
ArKaos VJ 3.5.1快速入门 

 

ArKaos VJ是一款可以通过MIDI设备、电脑键盘或电脑灯控台控制的视频软

件。它可以提供比其它硬件媒体服务器更高的灵活性，只需一台经济型电脑就能

播放出高质量的视频画面。ArKaos VJ支持所有普通的电影格式、图像和Flash

动画格式，并支持摄像机实时视频流。同时，它内置了超过60种用户自定义效果

和40种预先下载的FreeFrame效果。只需简单调用一些视像和效果，就能建立出

色的视频演出。 

现在，就让我们一起来学习ArKaos VJ的使用方法： 

 

 

第一章 ArKaos VJ 基础介绍 

一、启动ArKaos VJ 3.5.1 

双击桌面ArKaos VJ 3.5.1 FC1图标进入ArKaos VJ。 

 

 



二、新建一个演出 

点击菜单栏“File”->“New”，弹出一个Save（保存演出）窗口，选择一

个路径，输入文件名，点击“保存”。如下图所示： 

 

 

三、软件控制界面 

当你新建一个演出以后，就会出现以下界面： 



 

这个就是ArKaos VJ的控制界面。它包括五部分： 

 

第一部分是Synth（合成）窗口。如下图：  

 

这个窗口显示出Patch（配接）的名称，并可以让你选择其它的Patch（MIDI

模式和电脑键盘模式都包含128个Patch）。另外这个窗口还包括两个快捷按钮：

全屏显示按钮和自动演出按钮。 

 

第二部分是Visuals（视像）窗口。如下图： 

 



这个窗口包括4种不同的视像类型：第一种是静止图片；第二种是电影；第

三种是视频流；第四种是Flash文字。如果视像窗口关闭，可点击菜单栏“Synth”

->“Visuals⋯”重新打开。 

 

第三部分是Effects（效果）窗口。如下图： 

 

这个窗口里面包含了68种内置效果，另外还支持额外的FreeFrame效果（内

置40个FreeFrame效果）。如果效果窗口关闭，可点击菜单栏“Synth”->

“Effects⋯”重新打开。 

 

第四部分是Preview（预览）窗口。如下图： 

 

这个窗口可以让用户预览视像与效果合成后的输出视频。如果预览窗口关

闭，可点击菜单栏“ArKaos”->“Show Preview”重新打开。 

 



第五部分是Patch（配置）窗口。 

在ArKaos VJ 3.5.1版本里面，有三种触发模式： 

 

MIDI键盘触发模式，如下图： 

 

这种模式是通过MIDI键盘来触发视频的。这个窗口模拟的是一个MIDI的键

盘。 

 

电脑键盘触发模式，如下图： 

 

这种模式是通过电脑键盘来触发视频的。这个窗口模拟的是一个电脑的键

盘。 

 

DMX触发模式，如下图： 



 

这种模式是通过DMX电脑灯控台来触发视频的。 

 

四、普通模式和HW（硬件）模式 

ArKaos VJ具有普通模式和HW（硬件）模式。普通模式是只要电脑带有VGA

信号输出的显示卡就可以使用的模式；HW（硬件）模式则是需要电脑的显示卡带

有GPU图形加速芯片，进行图形运算的硬件加速模式。如今的中高端的显示卡基

本都具有GPU，也就是可以使用HW（硬件）模式。ArKaos VJ在运行普通模式和HW

（硬件）模式时，界面显示会有所不同。如下图所示： 

 

普通模式： 

 

 

HW（硬件）模式： 

 

 

点击菜单栏“Edit”->“Preferences”->“ArKaos Engine⋯”，可以选



择是否激活HW（硬件）模式。如果显示卡不支持就会不可选，如下图所示： 

 

 

五、输入视像 

ArKaos VJ可支持.MOV、.AVI、.SWF、.WMV、.MPG、.MPEG、.ASF格式的视

频输入以及.BMP、.JPG、.JPEG、.PCT、.PICT格式的图片输入。输入视像的方法

有三种： 

 

使用鼠标拖曳的方法：(如下图) 

1) 打开保存视像的文件夹 

2) 选择要输入的视像 

3) 用鼠标拖曳到Visuals的窗口 



 

 

使用“Import⋯”命令：(如下图) 

1) 点击菜单栏“File”->“Import⋯”弹出以下对话框： 

 

2) 点击选择输入视频或图片 

3) 弹出一个对话窗口，指定一个视像文件后点击“打开”，这时视像的图标就

会自动添加到Visuals的窗口里面。 

 

使用“Import”按钮：（如下图） 

1) 在Visuals窗口里面选择想要添加视像的类型 



 

2) 点击 按钮 

3) 弹出一个对话窗口，指定一个视像文件后点击“打开”，这时视像的图标就

会自动添加到Visuals的窗口里面。 

六、删除视像 

删除视像有两种方法： 

方法一：在Visuals窗口中选择需要删除的图像，点击 即可删除。 

方法二：在Visuals窗口中选择需要删除的图像，点击菜单栏“Edit”->“Clear”

即可删除。 

 

七、预览视像 

假如你在Visuals窗口里面输入了大量的视像，然而要记住所有这些视像的

内容不是一件容易的事情，那么你可以直接双击图标就能对视像进行预览，这个

过程并不会真正去触发它。如下图所示： 



 

 

 

第二章 ArKaos VJ的电脑键盘和MIDI键盘控制 

一、创建一个视像效果层 

电脑键盘触发模式 

 

1. 把视像和效果分配到电脑键盘 

在电脑键盘触发模式下，ArKaos VJ是将所需的视像和效果分配到按键上的。

每个电脑键盘按键都分为两部分：按键左边分配给视像，按键右边分配给效果。

如下图所示： 

 

分配方法十分简单，只需用鼠标把视像和效果分别拖曳到电脑键盘的按键

上就可以了。如下图所示： 



 

 

2. 播放一个视像效果层 

触发被分配了视像和效果的按键就能播放视频。按下键盘按键，视频就会

播放。如下图所示： 

 

 

松开按键视频就会取消播放。如果想循环播放视频，可使用快捷键“Shift

＋需要触发的按键”或打开视像属性窗口点击“Latch”。如下图显示： 



 

这时只要按一下按键就能播放视频，再按一下就会取消播放。 

 

如果想全屏播放，可以点击 。如果想退出全屏播放，只需点一下鼠标左

键。 

 

ArKaos VJ最多可同时运行50层。用户可点击菜单栏“Synth”->“Layers⋯”

修改同时运行视像效果层的最大数目。如下图所示： 

 

 

3. 编辑视像和效果 

ArKaos VJ允许用户编辑每一个视像效果层的属性。每一个视像效果层属性

分为视像属性和效果属性。 

 

1) 编辑视像属性 

双击电脑键盘按键左边的视像图标，打开视像属性对话窗口。如下图所示： 



 

 

以下是这个对话窗口的参数内容： 

 Horizontal position——水平位置，可设左、中、右或任意水平位

置 

 Vertical position——垂直位置，可设上、中、下或任意垂直位置 

 Size——可设原始、一半、两倍、全屏、成比例缩放或任意像素 

 Layer priority——层优先级，可设总是在前面、总是背景或无优先

级 

 Feedback——可设局部反馈、全局反馈或无反馈 

 Mask——蒙版设定。里面包括Background Copy（背景复制）、Luminance

（亮度）、Chrominance（色度）、Alpha from Source（Alpha源）模式。

当蒙版设定选择亮度/色度时，可以再设置亮度/色度的带宽、平滑度、

滤波器的类型。 

 Copy Mode——复制模式。里面包括Source Copy（源复件）、Transparent



（透明）、Addition（加法）、Subtraction（减法）、Multiplication（乘

法）、Minimum（最小）、Maximum（最大）模式，一般我们如果需要输出

多个层的时候，就可以选择不同的复制模式来进行图层的叠加。 

 Movie Speed——电影速度控制模式 

 Movie Loop——电影循环模式 

 

如果输出的视像是Flash文字，那么就可以在下面的“Flash Text”修改文

字内容。例如我们把文字改为：Hello。如下图所示： 

 

点击“OK”后触发按键播放视频。如下图所示： 



 

这时输出的文字就变成了“Hello” 

 

如果用户需要输出视频流，必须先把视频装置正确连接到电脑上并设置好，

才能在视频流列表中显示出来。然后就可以像编辑其它视像的方法来对视频流进

行操作。如下图所示： 

 

 

2) 编辑效果属性 



双击电脑键盘按键右边的效果图标，打开效果属性对话窗口。如下图所示： 

 

效果属性窗口的内容会根据所选的效果不同而各异，用户可以根据自己的

需要修改里面的内容。 

 

4. 清除按键上的视像或效果 

清除按键上的视像或效果有三种方法： 

方法一：用鼠标点击按键上需要清除的视像或效果的图标，再点击菜单栏“Edit”

->“Clear”即可清除。 

方法二：用鼠标点击按键上需要清除的视像或效果的图标，再点击菜单栏“Edit”

->“Cut”即可清除。不过所清除的视像或效果会放置在剪贴板中用于之后的粘

贴操作。 

方法三：用鼠标点击按键上需要清除的视像或效果，再使用快捷键“Ctrl＋

Delete”即可清除。 

 



MIDI键盘触发模式 

 

1. 把视像和效果分配到MIDI键盘 

在MIDI键盘触发模式下，ArKaos VJ是将所需的视像和效果分配到键盘的白

键和黑键上的。每个MIDI键盘按键都分为两部分：按键上方分配给效果，按键下

方分配给视像。如下图所示： 

 

分配方法十分简单，只需用鼠标把视像和效果分别拖曳到MIDI键盘的按键

上就可以了。如下图所示： 

 

 

2. 播放一个视像效果层 



触发被分配了视像和效果的MIDI按键就能播放视频。按下MIDI键盘的按键，

视频就会播放。如下图所示： 

 

 

MIDI键盘触发模式的其它操作：编辑视像和效果、清除按键上的视像或效

果、同时运行层的最大数目的设置和触发全屏模式，都和电脑键盘触发模式的操

作一样。这里就不作重复介绍了。 

 

二、自动演出功能 

ArKaos VJ的自动节拍功能能够触发视像，结合ArKaos可视化器的节拍检测

运算功能 ，还可实现演出和输入音频或MIDI时钟的同步运行。 

设置好音频或MIDI输入后，打开自动演出窗口，这里有三种触发模式：音频输入、

MIDI时间码和手动输入触发。还可以设置延迟补偿、节拍的比率、自动换Synths

和Patches等。设置好参数后选择“Use Beat Detection”来激活自动节拍检测



功能。这时候，演出就能根据节拍来触发。如下图所示： 

 

 

三、使用Event Recorder 

Event Recorder（事件记录器）允许用户直接在ArKaos VJ里面录制演出。

这段演出既可以直接保存在Synth里面，又可以转换成.MOV、.WMV格式的视频输

出。点击菜单栏“ArKaos”的下拉菜单“Event Recorder”，打开事件记录器。

如下图所示： 

 

是“记录”按钮； 是“播放”按钮； 是“处理”按钮。 

 



录制“现场”演出的方法： 

1) 点击“记录”按钮，弹出“Event Recorder”设置窗口： 

 

2) 点击“Edit⋯”按钮可以修改名称 

3) 假如演出需要音频，可以点击“Select⋯”按钮输入音频 

4) 点击“Record” 按钮开始录制，这时用户可以开始触发视频，录制一段演

出。 

5) 点击“Stop” 按钮就可以停止录制。 

 

播放“现场”演出的方法： 

播放方法有两种： 

方法一：在列表中选择想要播放的演出，点击“播放”按钮，弹出对话窗口点

击“Play”按钮开始播放，点击“Stop”按钮停止播放。如下图所示： 

 

 

方法二：使用Patch窗口右下角的快捷播放按钮播放。如下图所示： 

 

先点击右边的“上”“下”按钮选择演出，再点击左边的“播放”按钮开始播放。



如下图所示： 

 

 

处理“现场”演出的方法： 

1) 选择需要处理的演出 

2) 点击“处理”按钮，弹出一个对话框，如下图所示： 

 

3) ArKaos VJ有苹果QuickTime和微软Windows Media两种处理方式，选择其中

一种。 

4) 弹出对话窗口，点击“Make”，修改文件名，选择保存路径，点击“保存”，

ArKaos VJ就会自动把我们的现场演出转成MOV或WMV格式的视频。如下图所

示： 



 

第三章 ArKaos VJ的DMX控制 

一、DMX控制方式简介 

 ArKaos的DMX控制共有三种不同的模式：简单控制模式，灯具控制模式的全

模式和灯具模式的简约模式。所谓灯具模式，其实是把ArKaos VJ这个软件当作

是一台电脑灯，视频的明暗度、大小、位置等各种参数都可以通过灯控台的各个

功能界面去控制。控制的时候只需要设定各个功能的参数，而不再需要记住每个

通道的定义。 

1、简单控制模式：它是针对低端控台，允许使用硅路控制模式来触发。和

键盘控制模式一样，需要预先定义好每个层的视像和效果。使用最简单的24路推

子控制器也可以轻松控制这种模式。 

2、灯具控制模式（全模式）：每层43个控制通道。它是针对专业的电脑灯

光控台，把电脑转换成完善的专业媒体服务器。启动后，可以控制多达8个视像

效果层，每个层的参数都可以直接从控台中独立控制。 

3、灯具控制模式（简约模式）：每层25个控制通道。它也是针对专业的电

脑灯光控台，而跟全模式的区别在于，它只针对ArKaos的普通模式，去除了硬件

模式中需要的控制通道。它也能控制8个视像效果层 



通过前面章节的介绍，相信大家对ArKaos这款VJ软件有了一定的了解，下面

就让我们一起进入它的DMX控制部分。我们会使用Martin LightJockey（后面简

称LJ）这款专业的电脑灯光控台为例子，去控制ArKaos的全模式。在今年五月份

最新发放的Martin LightJockey 2.7 built 1这个版本中，马田公司已经制作好

针对ArKaos灯具控制模式的灯库，我们现在可以直接添加，并轻松地使用。 

 

二、安装连接方法 

安装VCOM的驱动程序，把ENTTEC的Pro DMX USB插入电脑的USB端口上，系统

会报告发现新硬件，“USB Serial Convector”，并提示该硬件可以开始使用。这

台电脑就具备了为ArKaos接收DMX512信号的能力了。 

之后，我们就可以把电脑灯控台和ArKaos连接起来，原理如下图所示： 

 

 从电脑灯控台DMX输出端口到Pro DMX USB输入端口，用DMX512信号线连接。

然后再从Pro DMX USB直连端口串联余下的电脑灯或其它DMX使用设备。 



 

我们再看看LJ和ArKaos是如何的连接的。 

由于LJ也是电脑软件，使用硬件设备输出DMX信号，所以我们把电脑灯控台

与VJ整合在一起。LJ和ArKaos软件安装在同一台电脑上，也把它们各自的硬件设

备连接在该电脑的两个USB端口上。如下图所示： 

 

 我们从示意图中可以看到，虽然LJ和VJ整合了，但是当中也需要用DMX512信

号线连接。也就是说，从本质上，和普通的电脑灯控台控制原理是没有差异的，

只是现在我们仅节省了一台电脑或者是一个灯控台的硬件而已。 

 

注意：Pro ENTTEC DMX USB以及Martin的USB to DMX Interface都必须连接在与

电脑主板直接焊接的USB端口，不能使用任何USB延长线或者前后置的扩展端口。 

 

点击菜单栏“Edit”–>“Preferences”->“DMX Setup⋯”打开DMX设置对

话框。 



 

选择使用“ENTTEC Pro DMX USB”，设定灯具模式，选择使用全模式。 

 

点击“OK”确认以后，程序会自动地搜索该硬件，没有提示错误的话，安装

便完成了。我们就可以把ArKaos丢开了，因为我们已经可以用LJ完全地控制它了！

ArKaos的界面下方也从键盘变成了DMX监视窗口了： 



 

 

三、给LJ配接ArKaos。 

第二步，给LJ添加8层的灯具控制。对LJ熟悉的读者都知道，配置灯具就是

在菜单中选择“SETUP”然后选其中的“Fixture Configuration”。从图中，我

们可以看到，LJ的数据库备有灯具模式的全模式和简约模式，配置的全模式灯库

被划分为两项。 

 

其中1号是ArKaos普通模式的大部分参数控制，当中包含了27个通道，所有

的视像、效果、位置、大小等基本的参数都在其中。而2号则是ArKaos以HW（硬

件）模式为主的参数控制，当中包含16个通道，有视像的旋转、RGB的调节和效

果模式设定的控制。我们现在就把它配接8层： 



 

 

四、LJ的控制方式 

我们来看一下LJ里面控制ArKaos的功能界面。图片中放大了各个功能按钮 

1号：  

 

 

 亮度：控制对应层的亮度或者透明度 

 

 



 位置：控制对应的层在输出显示屏的位置 

 

 

 视像控制：控制对应层播放的速度和正反方向 

4个“视像速度”按扭：停止、正常、2倍、4倍 

3个“视像控制”按扭：正常、反方向、来回方向 

 

 

 视像及效果控制：控制对应层的素材和效果的种类以及序号选择 

4类视像，从左到右：图片、电影、视频流和Flash文字 

5类效果，从左到右：三维、视频、过渡、艺术和FreeFrame效果 



 

Vis.Idx为视像序号选择，序号从0-255，0为没有，对应1-255分别对应我们

添加到视像窗口的图片、电影、外部视频设备和Flash文字。 

Effects为效果序号选择，默认为1。 

如下图所示： 

 

 

而在DMX灯具模式控制下，Flash文字需要在菜单中的“Fixture Text”灯具

模式Flash文字下设定，1-63为Flash文字的序号。如图： 



 

 

 层蒙版控制：控制各层的叠加模式和蒙版 

6种叠加模式：透视、加、减、乘、最小和最大 

6种蒙版控制：无、亮度反射、亮度通带、色度反射、色度通带、Alpha源 

 

 

 视像其余参数控制：控制各层视像的参数 

14个参数从左到右分别是：亮度/色度中心点、亮度带宽、亮度平滑度、视

像循环模式、循环起始值、起始微调值、循环结束值、结束微调值、Z轴景深值、

Z轴景深值微调、视像垂直像素、垂直像素微调、视像水平像素、水平像素微调 



 

 

2号：  

 

 

 颜色对比度：控制RGB色彩、饱和度等 

 



 旋转与效果模式：控制视像X、Y、Z轴的旋转以及所选定效果的模式（固

定了6个通道控制，效果模式1-6根据选择不同的效果分配）。其中第7条

“Text”为Flash文字序号的选定 

 

 

五、例子 

通过上面的视图的介绍，大家会对LJ控制ArKaos有一个大致的认识，下面我

们手把手地教大家去运用。 

 

第一层：推起光亮度到100%，选择视像到MOVIE，序号为6，选择蒙版中复制

模式为加法，选择效果模式到3D，序号为0，其实默认就是3D模式序号1，现在我

们把效果除掉。如下图所示： 



 

 

第二层：亮度100%，视像MOVIE，序号为1，加法，缩小像素，方位移动到右

下角，效果序号0。如下图所示： 

 

 

第三层：亮度100%，视像MOVIE，序号为1，加法，缩小画面，放置在左上角，



效果3D序号1。如下图所示： 

 

 

现在我们看到一个背景为涂鸦，左上角有一个ArKaos字样，右下角有一个漂

亮妹妹头像。如下图所示： 

 

 

刚才界面中DMX的监视窗口中，也可以看到LJ控制的资料 



 

把它保存成为一个序列，以便以后跟其他灯光程序一并回播，达到灯光与视

频同步的效果。 

 

 

在这个基础上，读者们可以自己去调节一下别的效果或者参数，要是效果不

满意，可以清除当前的设定，重新载入刚才我们保存好的序列，继续发挥大家无

限的创意。 

 

六、其他的DMX控台 

 ArKaos的DMX控制方式并不仅仅局限于使用Martin的LJ。大部分主流的电脑

灯控台都有配备它的灯库文件。当中包括：爱富丽、BLULITE、CHAMSYS、COMPULITE、

ECUE、GRANDMA、HOG3、SUNLITE2004、VXCO、ZERO 88。当为这些控台装上了它

的灯库文件之后，就可以直接在各个功能界面中设定参数来控制了。 

 包括Martin LJ和上述提及的电脑灯控台，控制这款ArKaos VJ软件时与控制

投射图案的电脑灯的原理是一样的，而只是在现场投射的不是光斑而是视频。如



果读者正好使用着不是上述的灯控台，也不要紧，我们在附录中提供了ArKaos

的灯具模式全模式的43条通道的协议和各通道大致功能的简介，读者可以自行编

写灯库文件，或者使用43条数字硅路通道来控制。 

 

 

 

 

 

 

 

附录： 

现在，我们附上ArKaos的灯具全模式DMX通道协议以及各通道功能简介。 

 

5.2.2 通道功能 
 
通道C01                                                                                                                                                                                           
功能：调光 
      C08为0－31时，控制图层的透明度 
      复制模式不为透明时，C01只用于图层触发 
范围：  步骤：  描述： 
0－255  0－127  数值不为0时，开启图层 
 
通道C02 
功能：视像类型 
范围：  步骤：  描述： 

0－31   视像类型为图片  
32－63  视像类型为电影  
64－95  视像类型为现场摄像机  
96－127 视像类型为FLASH文字 

 
通道C03 

默认数值 
0 

 默认数值 
0 

 默认数值 
 0 



功能：视像索引 
范围：  步骤：  描述： 
0－255   0      无视像 
         1      第一视像 
         2      第二视像 
         …     … 
 
通道C04 
功能：效果类型索引 
范围：  步骤：   描述： 
0－255  0－31    三维效果  

32－63   视频 
64－95   过渡 
96－127  艺术效果 
128－159 FreeFrame 
…       … 

 
通道C05 
功能：辅助效果 
范围：  步骤：   描述： 
0－255   0      无效果 
         1      第一效果 
         2      第二效果 

…     … 
通道C06 
功能：复制模式 
范围：  步骤：   描述： 
0－255  0－31    透明  

32－63   加法 
64－95   减法 
96－127  乘法 
128－159 最小 
160－191 最大       
…       … 

 
 
 
 
通道C07 
功能：蒙版模式 
范围：  步骤：   描述： 

0－31    无   
32－63   亮度－反射 
64－95   亮度－通带 

  默认数值 
 0 

  默认数值 
 1 

默认数值 
 0 

默认数值 
0 



96－127  色度－反射 
128－159 色度－通带 
160－191  Alpha源码 

 
通道C08 
功能：亮度/色度中心点 
范围：  步骤：   描述： 
0－255  0－255   亮度/色度滤波器中心点 
 
通道C09 
功能：亮度/色度带宽 
范围：  步骤：   描述： 
0－255  0－255   亮度/色度滤波器带宽 
 
通道C10 
功能：亮度/色度平滑度 
范围：  步骤：   描述： 
0－255  0－255   亮度/色度滤波器的平滑参数 
 
通道C11 
功能：电影速度控制 
范围：  步骤：   描述： 
0－255    0      电影停止 
          64     电影按正常速度播放 
          128    电影以2X速度播放 
          255    电影以4X速度播放 
 
通道C12 
功能：电影速度控制模式 
范围：  步骤：   描述： 
0－255  0－31    C11为正常速度控制 
        32－63   C11为正向反向速度模式 
        64－95   C11为来回反弹（Ping Pong）速度模式 
 
通道C13 
功能：循环模式 
范围：  步骤：   描述： 
0－127  0－31    播放所有帧   

32－63   选择C16－C17和C18－C18帧 
64－95   随机跳转1 
96－127  随机跳转2 
  

通道C14-C15 
功能：开启循环 

默认数值 
128 

默认数值 
50 

默认数值 
50 

默认数值 
64 

默认数值 
0 

默认数值 
0 

默认数值 
0 



范围：    步骤：   描述： 
0－65536  0        视频循环的首个图像 
          65535    视频循环的最后一个图像 
 
 
 
 
通道C16-C17 
功能：结束循环 
范围：    步骤：   描述： 
0－65536  0        视频循环的首个图像 
          65535    视频循环的最后一个图像 
 
通道C18-C19 
功能：水平（坐标轴X）的16比特数值 
范围：    步骤：   描述： 
0－65536  0        屏幕的左端坐标   
          65535    屏幕的右端坐标 
 
 
通道C20-C21 
功能：垂直（坐标轴Y）的16比特数值 
范围：    步骤：   描述： 
0－65536  0        屏幕的顶点坐标 
          65535    屏幕的底点坐标 
 
 
通道C22-C23 
功能：坐标轴Z的16比特数值 
范围：    步骤：   描述： 
0－65536  0        最近点坐标 
          65535    最远点坐标 
 
通道C24－C25 
功能：水平尺寸的16比特数值 
范围：    步骤：   描述： 
0－65536  0        尺寸为输出屏幕的0％ 
          65536    尺寸为输出屏幕的100％ 
 
 
通道C26－C27 
功能：垂直尺寸的16比特数值 
范围：    步骤：   描述： 
0－65536  0        尺寸为输出屏幕的0％ 

默认数值 
65535 

默认数值 
32768 

默认数值 
32768 

默认数值 
32768 

 

默认数值 
65536 

默认数值 
65536 



          65536    尺寸为输出屏幕的100％ 
 
通道C28－C29 
功能：HW模式下的X轴旋转 
范围：    步骤：   描述： 
 
 
通道C30－C31 
功能：HW模式下的Y轴旋转 
范围：    步骤：   描述： 
 
通道C32－C33 
功能：HW模式下的Z轴旋转 
范围：    步骤：   描述： 
 
 
通道C34  
功能：HW模式下的红色电平 
范围：    步骤：   描述： 
0－255             初始电平为255 
 
通道C35 
功能：HW模式下的绿色电平 
范围：    步骤：   描述： 
0－255             初始电平为255 
 
通道C36 
功能：HW模式下的蓝色电平 
范围：    步骤：   描述： 
0－255             初始电平为255 
 
通道C37 
功能：文本索引 
范围：    步骤：   描述： 
0－255             Flash动画效果的文本辅助 
 
通道C38－C43 
功能：E1、E2…..E6 
范围：    步骤：   描述： 
                   E1＝效果的首个参数 
                   E2＝效果的第二个参数 
                   … 
                   E6＝效果的第六个参数 

默认数值 
32768 

默认数值 
32768 

默认数值 
 32768 

 默认数值 
128 

默认数值 
128 

默认数值 
128 

默认数值 
0 

默认数值 
0 


